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Important Instructions to examiners:
1) The answers should be examined by key words and not as word-to-word as given in the model
answer scheme.
2) The model answer and the answer written by candidate may vary but the examiner may try to
assess the understanding level of the candidate.
3) The language errors such as grammatical, spelling errors should not be given more Importance
(Not applicable for subject English and Communication Skills).
4) While assessing figures, examiner may give credit for principal components indicated in the
figure. The figures drawn by candidate and model answer may vary. The examiner may give
credit for any equivalent figure drawn.
5) Credits may be given step wise for numerical problems. In some cases, the assumed constant
values may vary and there may be some difference in the candidate’s answers and model
answer.
6) In case of some questions credit may be given by judgement on part of examiner of relevant
answer based on candidate’s understanding.
7) For programming language papers, credit may be given to any other program based on
equivalent concept.
Q.
No
.
1.

Sub
Q.N.

Answer

Marking
Scheme

a)
(i)
Ans.

Attempt any SIX of the following:
What is form factor? List different form factors of motherboard.
Form Factor:
Shape and layout of motherboard is called form factor. It refers to
physical dimensions (size and shape), certain connectors, screw holes,
position where the board will fit. It affects individual components and
shape of computer’s case.
List of Form factor:
 AT
 Baby AT
 ATX
 Mini-ATX
 Micro-ATX
 Flex ATX
 LPX
 Mini LPX
 NLX.

12
2M
Form
Factor
1M

List 1M
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What is FAT? List features of FAT 32.

2M

FAT is a kind of index used by the operating system to keep track of the
information stored on the hard disk. FAT keeps a map of complete surface
of the disk drive, which area is free, which area is bad, which area is taken
by which file etc.

Feature
Maximum Partition Size
Maximum File Size
Maximum File Name
File/Folder Encryption
Fault Tolerance
Security
Compression
Compatibility

(iii)
Ans.

17428

FAT 1M

FAT32

2TB
4GB
8.3 Characters
No
No
Network Only
No
Win 95/98/2000/XP and the
derivations
What is LCD? Write advantages of LCD.
A liquid crystal display (LCD) is a type of display technology that
makes use of liquid crystals that open or close when stimulated by an
electric current. These liquid crystals are the basis for LCD
technology. LCD technology is preferred to other display
technologies because it is lighter, thinner and uses less power.
Advantages of LCD Monitors:
1. Require less power - Power consumption varies greatly with
different technologies. The average is about 45 watts for a 19-inch
LCD display. LCDs also produce less heat.
2. Smaller and light in weight - An LCD monitor is significantly
thinner and lighter than a CRT monitor, typically weighing less
than half as much. In addition, you can mount an LCD on an arm
or a wall, which also takes up less desktop space.
3. More adjustable - Tilt up-down, swivel, orientation from
horizontal to vertical mode is possible.
4. Less eye strain - Because LCD displays turn each pixel off
individually, they do not produce a flicker like CRT displays do.
In addition, LCD displays do a better job of displaying text
compared with CRT displays.
5. Flicker free screen.
6. More usable display area than on comparably sized CRT.
7. Low radiation

List of
Feature
s 1M

2M
LCD
1M

Any 2
advanta
ge 1/2M
each
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What is RAM? Explain types of RAM.
Random access memory (RAM) is a type of data storage used in
computers that is generally located on the motherboard. This type of
memory is volatile and all information that was stored in RAM is lost
when the computer is turned off.

2M
RAM
1M

Types of RAM:
1. Static RAM: - Static Random Access Memory (Static RAM or
SRAM) is a type of RAM that holds data in a static form, that is, as
long as the memory has power.
Any 2
2. Dynamic RAM: - Dynamic random access memory (DRAM) is a
types
type of random-access memory used in computing devices (primarily
½M
PCs). DRAM stores each bit of data in a separate passive electronic
each
component that is inside an integrated circuit board. Each electrical
component has two states of value in one bit called 0 and 1.
3. Synchronous Dynamic RAM: - Synchronous dynamic random
access memory (SDRAM) is dynamic random access memory
(DRAM) with an interface synchronous with the system bus carrying
data between the CPU and the memory controller hub. SDRAM has a
rapidly responding synchronous interface, which is in sync with the
system bus. SDRAM waits for the clock signal before it responds to
control inputs.
4. Double data rate SDRAM:-Double data rate synchronous
dynamic random access memory (DDR SDRAM) is a type of
random-access memory module that allows for higher transfer rates
and faster performance compared to earlier RAM modules. DDR
SDRAM transfers memory on both the rising edge and falling edge of
a clock cycle, doubling the transfer rate. This is where the name
“double data rate” comes from.
Compare online UPS and offline UPS (any 2 points)
2M
Online UPS
Offline UPS
1. Complex and expensive
1. Simplest and least expensive.
2. Battery is continuously
2. Battery is charged when AC
Any 2
charged, delivers DC power to
mains are on, when AC mains
points
inverter for converting to AC
are off, battery discharges and
1M each
and supplying to PC.
supplies power to PC.
3. Switching does not occur.
3. Switching occurs.
4. It is at high speed so as to
4. It is not at high speed,
avoid resetting of PC.
therefore resetting may occur
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some times.
5. Spikes are generated

Explain USB features.
Features of USB:
1. Up to 127 different devices can be connected on a single USB bus.
2. Initial USB standard supported 12 Mbps transfer rate. Currently 60
Mbps is supported.
3. Supports wide range of peripherals such as keyboard, mouse,
printer, FDD, game pad, joystick etc. 4. Devices are not daisy
chained. Each device is connected to USB hub, which is an
intelligent device interacting with the PC on one side and USB
peripheral devices on the other side.
5. A USB device can be connected without powering off the PC. The
plug and play feature in the BIOS together with intelligence in the
USB device takes care of detection, device recognition and
handling.
6. USB controller in the PC detects the presence or absence of USB
devices and does power allocation.
7. The CPU/software initiates every transaction on the USB bus.
Hence the overhead on the PC software increases.
State any four printer problems.
(Note: Any other problems shall be considered)
1. Printing takes too long.
2. Print Garbage.
3. Paper jam.
4. Printer isn’t printing.
5. Multiple sheets are drawn.
6. Print jobs stuck in queue
Attempt any TWO of the following:
Explain concept of cache memory with advantages and
disadvantages.
Cache is a smaller, faster memory which stores copies of the data
from the most frequently used main memory locations. When the
processor needs to read from or write to a location in a main memory,
it first checks whether a copy of that data is in the cache. If so, the

2M

Any 4
points
½M
each

2M

Any 4
points
½M
each
8
4M
Concept
2M
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processor immediately reads from or writes to the cache, which is
much faster than reading from or writing to the main memory. The
CPU uses cache memory to store instructions that are repeatedly
required to run programs, improving overall system speed.
ADVANTAGES:
1. Enhances the speed of system or improving performance
2. Reduces a traditional system bottleneck.
3. The access time is very small.
4. Instructions take less time to execute.
5. Data transfer gets quicker.
6. Cache memory is intelligent memory.
7. It holds current working set of code and data.
8. Reduces wait states.

(ii)
Ans.

DISADVANTAGES:
1. Size is small
2. Cost is very high.
List recording techniques. Explain MFM encoding scheme.
List: FM, MFM, RLL, Perpendicular Recording.
M F M Recording Technique: In MFM number of pulse are reduced
and able to store more data without any data and synchronization
loss. In MFM recording the 0s and 1s are encoded as given below.

Advanta
ges 1M

Disadva
ntages
1M
4M

List 1M

1 is always stored as no pulse, and a pulse(NP)
0, when preceded by another 0, is stored as a pulse, and no pulse(PN)
0, when preceded by a 1, is stored as two no pulses(NN)
If 1001 to be recorded on the disk surface using the MFM storage
method, it would be stored as NP NN PN NP.

MFM
explanat
ion with
Example:-Given bit stream , 10110111, the following table gives the example
recording using MFM:
3M
p
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What are various key switches? Explain membrane switch.
Types of key switches of Keyboard:
1. Capacitive switch
2. Opto –electronic switch
3. Membrane switch
4. Mechanical switch
5. Rubber Dome switch

17428
4M
List 1M

Working of membrane keyswitch:
It is multilayer plastic or rubber assembly, two rubber or plastic sheet Workin
are used as row and column conductor sheet and row and column
g of
sheet having lines made up of silver or some other conductor ink row membra
and column sheet separated by another sheet with holes at key top
ne
position. When Key pressed- it forces the row conductor sheet keyswitc
through the hole to touch the column conductor sheet, Row conductor h 3M
lines now touches with column conductor lines, key contact is made,
Keyboard interface interpreted as key is pressed.

2.
a)
Ans.

Attempt any FOUR of the following:
16
Draw and explain North/South bridge architecture.
4M
Intel’s earlier chipset were broken into multi-tired architecture known
as North Bridge and South Bridge components as well as Super I/O
chip.
North Bridge: it is the connection between the high speed processor
bus and the slower AGP & PCI buses. South Bridge: it is the bridge Explana
between PCI bus and even slower ISA bus. Super I/O chip: contains tion 2M
commonly used peripheral items all combined in single chip.
Northbridge is also referred to as PAC (PCI-AGP) controller is the
main component of the motherboard and only motherboard circuit
(besides the processor) that runs at the full motherboard speed. It
serves as the four way connection between CPU, Memory, Video
card and south bridge.
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It handles communication between CPU, RAM, AGP or PCI Express
and the Southbridge.
South bridge is the lower speed component of the chipset. The south
bridge connects to the 33MHz PC and contains the interface to ISA
bus. It also contains dual ATA/IDE hard disk controller interfaces,
one or more USB interfaces, CMOS RAM, real time clock functions,
interrupt controller, DMA controller.
Super I/O chip: contains commonly used peripheral items all
combined in a single chip.

Diagra
m 2M

b)

Explain hard disk drive construction.
(Note: Diagram is optional)

4M

Ans.
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A hard disk drive is a sealed unit that a PC uses for nonvolatile data
storage. Nonvolatile, or semi-permanent, storage means that the
storage device retains the data even when no power is supplied to the
computer.
A hard disk drive contains rigid, disk-shaped platters, usually
constructed of aluminum or glass.
Hard Disk Drive Components:
1- Disk platter
2- Read/Write head
3- Head arm/Head slider
4- Head actuator mechanism
5- Spindle motor
6- Logic board
7- Air filter
8- Bezel
9- Cables & Connectors

List of
compon
ents 1M

1. Platters: A hard disk drive has one or more flat circular disk called
platters. Platters are made of an aluminum alloy, which provides both
strength and light weight. These platters are coated with magnetizable
media coating which can store information magnetically.
2. Read /Write Head: A hard disk drive usually has one read/write
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head for each platter surface, meaning that each platter has two sets of
read/write heads - one for the top side and one for the bottom side.
These heads are connected, to a single movement mechanism so that
all read write heads move together.
3. Head Actuator Mechanism: This mechanism moves the heads Explana
across the disk and positions them accurately above the desired tion 3M
cylinder.
4. Head Arm/Head Slider: The arm on which the Read/Write head
is located, It is made in catamaran sailboat shape. Lower weight
allows for faster acceleration and deceleration
5. Spindle Motors: The motor that spins the platters is called the
spindle motor, because it is connected to the spindle around which the
platters revolve. Spindle motors in hard disk drives are always
connected directly; no belts or gears are involved. The spindle motor
also must be precisely controlled for speed.
6. Logic Boards: It controls all these different parts of HDD. It
contains the electronic components that control various sections of
the HDD. It also acts as an interface between the hard disk drive and
the computer.
7. Air Filters: Nearly all hard disk drives have two air filters. One
filter is called the recirculation filter, and the other is called breather
filter. The recirculating air filter is used to filter any particles
dislodged from inside the drive such as scarp of the disk media
8. Bezel: Front faceplate provided on the HDD.
9. Most drives have at least these three types of connectors: -Interface
connector(s) -Power connector -Optional ground connector (tab)
Explain characteristic of CRT monitor.
4M
Characteristic of CRT monitor:
1) Frame Rate : This is used to show the number of times a screen
full of information is produced per second or the number of times a
frame is shown (in one second) on the monitor. OR Frequency at Any 4
which whole screen is redrawn.
characte
2) Resolution: Resolution describes the number of potential pixels ristic of
the monitor is capable of displaying.
CRT
Resolution = Total Horizontal Pixels x Total vertical pixels.
monitor
3) Dot pitch: It is the distance between each group (triad) of red, blue 1M each
and green phosphors. A smaller dot pitch helps produce sharper and
clearer image
4) Video bandwidth: It is the highest input frequency a monitor can
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handle and helps in determining the resolution capabilities of the
monitor, bandwidth is measured in MHz. Higher the video
bandwidth, better the image quality.
5) Horizontal scanning: Scanning of the electron beam on the screen
of the monitor is called raster scanning. The tracing of the horizontal
lines in synchronism with H – Sync pulse is called Horizontal
Scanning
6) Vertical Scanning Frequency:
The frequencies at which the monitor repaints the whole screen, It is
also called as vertical scanning frequency. Unit: Hz (no. of cycles per
second)
With neat diagram explain working of opto mechanical mouse.
Opto mechanical mouse:

4M

Any
suitable
diagram
1M

 A combination of LED and photo detector is used to sense the
distance traveled by the mouse.
 When mouse is moved across a flat surface, the ball protruding
from the underside of the mouse and touching the surface starts to
rotate in the direction of the movement.
 Rotating ball touches and turns two rollers inside the mouse.
These rollers are mounted at 90 degree angles to each other.
 One roller is used for vertical movement and the other roller is
used for horizontal movement of cursor on the screen.

Workin
g 3M
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 Each roller is connected to a wheel, which rotates with movement
of rollers.
 As the wheel rotates, a pair of photo detector detects the number
of openings on the wheel passing between them.
 Each opening on the wheel allows light from the LED to fall on
the photo detector and generate electrical signal.
 The direction in which the mouse is moving can be found out by
finding the number of signals from vertical and horizontal rollers.
 These signals are sent serially to the PC over the mouse cable.
The mouse driver software converts these signals into distance
direction and speed necessary to move the cursor on the screen.
 Pressing a button on the mouse sends a signal to the PC.
 Based on which button is pressed, how many times it is pressed
and the position of the cursor at the time of pressing the button,
the mouse driver performs the task.
Draw and explain linear power supply.
Linear Power Supply:

4M
Linear
power
supply
Diagra
m 2M

Linear Power supply converts AC to DC voltages.
Transformer:
Transformers Power supplies contain two main circuits: a primary
side and a secondary side.
Explana
The primary side connects to the power source, and the secondary tion 2M
side connects to the load.
Transformer used to convert the voltage from mains to a different,
usually lower voltage.
The incoming AC voltage is stepped down to a lower AC voltage.
Rectifier: Then rectification is done by a set of diodes, transforming
this AC voltage into pulsating voltage DC (Full-wave bridge rectifier)
Filter: The next step is filtering, which is done by an capacitor,
transforming this pulsating voltage into almost DC, A filter capacitor
is used to maintain a constant dc level with minimum ripple.
Regulator: Voltage regulating stage is necessary, done by a zener
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diode or by a voltage regulator integrated circuit. After this stage the
output is true DC voltage.
Explain SCSI connectors.
External connector types:1. D-Shell (D-Sub, DD)- SCSI-1 defined a 50 pin D-Shell
connector, D-shaped metal shell that goes around the pins on the
male half of the connector.
2. Centronics- 50-pin connector, two rows of flat contacts are used,
two latches on both side used to hold connector in plat,
Centronics latch-style connectors for external connectors. Also
called “Alternative 2” external connector
3. High Density (HD)- The SCSI-2 revision added a highdensity,50-position, D-shell connector which are now called
Alternative 1. Space between pins are reduced ,Smaller , cheaper
and easier to use ,68 pin version called Alternative 3
4. VHDCI – very high density cable interconnect- A 68conductor also called micro centronic connector, Contacts much
smaller and closer together( Alternative 4)

4M

Externa
l
connect
or 2M

Internal (unshielded)connectors:
1. Regular Density: The SCSI-1 standard defined a single
connector type for internal narrow (8-bit) devices. This is a
rectangular connector with two rows of 25 pins. This connector Internal
type is very similar to that used for IDE/ATA devices, except that connect
there are five extra pins in each row. It is most often seen in older or 2M
devices and also some newer, slower drives. It is called
unshielded "Alternative 2" in the current SCSI standards.
2. High Density: SCSI-2 defined two new connector types, which
are both called high density because their pin spacing is half that
of the older SCSI-1 connectors, making them much smaller.
These are the most common SCSI connectors used today within
the PC box. The narrow, 50-pin version is unshielded connector
"Alternative 1" and the 68-pin version is "Alternative 3".
3. Single Connector Attachment (SCA): "Alternative 4" in the
SCSI standards for unshielded connectors doesn't actually refer
to cable connectors, but the connector used for the single
connector attachment system for backplane-connection of SCSI
drives.
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Attempt any FOUR of the following:
Draw and explain various terms related to hard disk.
(Note: Any other relevant diagram shall be considered)
Terms related to Hard disk:

16
4M

Any
suitable
diagram
1M

Track :
Each side of HDD platter’s surface is divided into concentric circles
called tracks.
Sector:
Tracks are divided into sectors. The formatting program divides disk
surface into sectors by writing magnetic pattern on disk surface.
Different HDD capacities have different number of tracks. 512 bytes
data can be stored in each sector. Sector number starts from 1.

Any 3
terms
Cylinder: In a hard disk, same tracks of different platters form an 1M each
imaginary structure called a cylinder. Data is stored in the disk
cylinder by cylinder.
Cluster :
• When OS writes some information on the hard disk, it does not
allocate the space sector wise, instead uses a new unit of storage
called “Cluster”.
• Clusters are the minimum space allocated by DOS when storing any
information on the disk.
• To store only one byte long information on the disk it requires
minimum one cluster area on the disk surface.
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Master Boot Record (MBR): The master boot record is the small bit
of computer code that the BIOS loads and executes to start the boot
process. This code, when fully executed, transfers control to the boot
program stored on the boot (active) partition to load the operating
system.
Draw and explain block diagram of CRT colour monitor.
Block diagram of CRT color Monitor:

4M

Block
diagram
2M

CRT Color Monitor has three sub sections, namely, Video drive
circuits, Vertical drive circuits and horizontal drive circuits.
Power circuit: This is a synchronous type switching power circuit,
which consists of Line filter, rectifier, PWM regulator and SMPS Explana
converting transformer. This is used provide different DC voltages tion 2M
required in the monitor.
Video drive circuits::
It contains circuits for displaying the video information as dots on the
CRT screen. It receives video signal from the PC and displays it on
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the monitor. Three video drive circuits are needed, one for each
primary color (RGB). Video signals are represented as analog signals
which allow the intensity of each color to be varied. The CRT is
designed to provide three electron beams which are directed at
corresponding color phosphors. By varying the intensity of each
electron beam, virtually any color can be produced.
Vertical Drive Circuit: They contain the vertical oscillator circuit
and a multiplexer. The V SYNC signal is applied to the vertical
oscillator IC.
Horizontal Drive Circuit: H-sync is applied to the horizontal drive
IC. Horizontal oscillator frequency is controlled by H1, H2 inputs.
FBT (FLY BACK TRANSFORMER) is used to provide various
voltages to different circuits such as focusing circuit, circuit for
changing contrast and brightness etc; It also generates voltages for
electron beam retrace.
Explain working of flat bed scanner with the help of block
diagram.
Flat Bed Scanner:

4M

Diagra
m 2M






Light source illuminates piece of paper face down against glass
window above the scanning mechanism.
Explana
Motor moves the scan head beneath the page.
The scan head captures light reflected from individual areas of the tion 2M
page.
Reflection takes through system of mirrors.
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Lens focuses the reflected beam of light on light sensitive diodes.
The diodes generate electric current corresponding to the amount
of reflected light.
 White spaces reflect maximum light, which generates maximum
voltage.
 ADC converts each analog signal of voltage to digital pixel
representing the scanned area.
 For Monochrome Scanner 1 bit per pixel is stored-either on or off.
 For Color Scanner, the scan head makes three passes under the
images.
 Reflected light on each pass is directed through red, green and
blue filter before it strikes the original image.
 Signals from the three passes are converted into digital
information and stored to represented, green or blue color value
of the scanned area on the page.
 This digital information is sent to the software in the PC, where
data is stored in a format on which OCR can work.
Explain following terms related to power supply problem:
(i) Blackouts
(ii) Brownouts
(iii) Surge
(iv) Spikes
(Note: Diagram is optional)
(i) Blackouts: It is the complete loss of electrical power where
voltage and current drop to a very low value (typically zero).

4M

Each
term 1M

(ii) Brownouts: It is the under voltage condition caused by faulty
electrical wiring or excessive electrical load on an AC circuit.
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(iii) Surge: It is overvoltage that last for more than one cycle. Surges
are caused when some heavy electrical load is suddenly switched off.
They are voltage conditions that take place over relatively long
periods of few milliseconds.

(iv) Spikes: Spikes are very high voltage, split second events that can
disrupt the operation of electronic devices such as computers. OR It is
a large over voltage condition that occurs over short duration of few
microseconds.

e)
Ans.

Explain RS32 interface basics.
(Note: Any other relevant explanation shall be considered)
RS 232 Basics:
• Serial port RS232C supports asynchronous Full duplex serial data

4M
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communication
• RS stands for Recommended Standard
• It can be 25 pin D type interface or 9 pin D type interface.
Suitable
The communication takes place between a computer and a serial explaina
device/terminal as given in the following diagram.
tion 4M
The following signals are used in the RS 232 communication

CD (Carrier detect)

RXD (Receive data)
TXD (Transmit data)

DTR (Data terminal ready)
GND (Signal ground)
DSR (Data set ready)
RTS (request to Send)

Modem connected to
serial port has made
proper connection with
modem on other side.
Data send from DCE to DTE
and vice versa
It is used by computer to sends
data to the device to serial port
connect
Computer is ready for
communication
Provide necessary return path.
Device is ready for
communication.
Once clear to send is received,
device connected to serial port
inform that computer send
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request to send.
CTS (Clear to send)
Used by device connected to the
serial port to inform to the
computer that computer can
start data transmission.
RI (Ring indicator)
To call /communicate modem
by other device not computer
To inform computer someone
calling. Computer detected
ringing voltage on telephone
line
Explain any two types of maintenance of PC.
Maintenance of PCs:
Preventive Maintenance can be of two types:
a) Passive preventive maintenance
b) Active preventive maintenance

4M

Passive preventive maintenance procedure
It includes periodic care of external factor which affect working of
the PC i.e. Mainly providing the best possible physical and electrical
environment for the PC to operate.
Active preventive maintenance procedure
It describes several procedures to clean and lubricate all the major
components, cleaning all boards, connectors, contacts etc.
It also describes similar procedures for different peripheral devices
such as HDD, FDD, keyboard, printer, monitor etc.
It includes performing backups, antivirus and antispyware scans.
Active preventive maintenance Procedure:
Cleaning a system
Any 2
 Regular and through cleaning of the system removes any layer
Active
of dust and benefits the system in the long run.
Mainten
 Dust acts as thermal insulator, which prevents proper system
ance 1M
cooling,
each
 Excessive shortens the life of system components.
 Dust can contain conductive elements that can cause partial
short circuit in the system.
 Other elements in the dust can accelerate corrosion of
electrical contacts.
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 Following cleaning tools and solutions can be used to clean
the internal components, peripherals and the boards inside the
system.
Cleaning tools
 Contact cleaning solution Silicon –type lubricant (WD 40)
 Small brush computer vacuum cleaner
 Canned air Lint-free foam cleaning swabs
 Foam tape
Cleaning Solutions
 Standard cleaners
 Trichloroethane, Isopropyl alcohol, acetone, Freon.
 Contact cleaners/ lubricants
 Stabilant 22, WD 40.
 Dusters (Compressed gas to blow away dust)
 HFCs such as difluroethane, CO2
 Similar cleaning tools and solutions can be used with
peripheral devices such as keyboard, mouse etc and the gold
contacts of slot connectors, power supply connectors and all
other connectors.
System backups
The hardware in the PC can always be repaired or replaced, but the
data cannot.
For this purpose following procedure can be followed.
 Take backup of any data or important files.
 Delete all temporary files.
 Empty the recycle bin.
 Install antivirus updates.
 Run defragmentation program.
Some weekly maintenance procedures
 Take backup of important data and files.
 Delete all temporary files.
 Empty the recycle bin.
 Check and install antivirus software updates.
Some monthly maintenance procedures
 Clean the system and the peripheral devices.
 Create OS startup CD.
 Install OS updates.
 Install updated drivers of video cards, modems, sound cards
etc.
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 Check all the system fans and power supplies etc.
Passive preventive maintenance
 It involves taking care of the system from physical
environment and electrical problems.
 Physical conditions such as temperature, thermal stress, dust
and smoke contamination and shock and vibration.
Any 2
 Electrical issues such as ESD (Electro Static Discharge), Passive
power line noise and RFI (Radio frequency interference)
Mainten
ance 1M
Physical contributors to system failure
each
1) Prevention of dust and dirt
 Use dust covers when not in use.
 Use curtains on windows
 Use air conditioners for computer room.
 Avoid shoes into computer room.
 Avoid smoking near a PC.
 Use vacuum cleaner to clean the surrounding area of the PC
frequently.
2) Excessive temperature
Prevention
 Keep the cooling vents clear.
 Keep the system dust free from inside and outside.
 Keep the disks in cool dry location.
 Install air conditioners to maintain the room temperature.
3) Effect of Cold
Prevention
 Use room heater to maintain the room temperature.
4) Corrosion
Prevention
 Periodic cleaning.
 Clean the pins of ICs and connectors.
 Use organic solvent for cleaning the oxide layer and corroded
contacts.
5) Magnetic Effect
Prevention
 To avoid data loss due to magnetism, keep disks and
information cables away from the magnets.
6) Electrical contributors to system failure
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ESD (Electro Static Discharge)
Prevention
 Before touching any component we must discharge any
accumulated potential to ground. This can be done by touching
the ground area of the system.
 Use ground strap attached around your wrist. The other end of
the strap is connected to the system ground.
 Use anti-static mat.
 Do not wear synthetic clothes.
 The system should have good power line grounding.

4.
a)
Ans.

7) Power line noise :
Prevention
 Isolation.
 Shielding.
 Power grounding.
8) Radio Frequency interference (RFI):
Prevention
Put all the sources which can produce RFI away from the PC.
Attempt any FOUR of the following:
List and explain processor modes.
Processor Modes: Processor modes refer to the various operating
environment that affect the instructions and capabilities of the chip.
The processor mode controls how the processor sees and manages the
system memory and the tasks that use it. Different processor modes
are
1. Real mode
2. Protected mode
3. Virtual real mode.

16
4M

List 1M

1. Real Mode (16 bit software): These 16 bit operating systems and
applications are designed to run on original 8088 processor. The 16 Explana
bit instruction mode of 8088 is called the real mode. It has 20-bit tion 1M
segmented memory. In this mode, direct access to BIOS routines &
each
peripherals are available. There is no memory protection and no
multitasking at hardware level. Only one program can run at a time.
No built in protection exists to keep one program from overwriting
another program or even the operating system in the memory.
2. Protected Mode: It was introduced with 386 processor which was
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the first 32 bit processor and it could run entirely on 32 bit instruction
set. This new 32 bit mode was called protected mode because
software programs running in this mode are protected from being
overwritten in the memory. Such protection makes the system more
crash proof. There is no 1 MB limit in protected mode. This mode has
ability to multitask, meaning having the operating system manage the
execution of multiple programs simultaneously. It supports virtual
memory, which allows the system to use the hard disk to emulate
additional system memory when needed.

b)
Ans.

3. Virtual Real Mode: This emulates real mode from within
protected mode, allowing DOS programs to run. A protected mode
operating system such as Windows can in fact create
multiple virtual real mode machines, each of which appear to the
software running them as if they are the only software running on the
machine
Explain formatting in detail.
Formatting
• Hard Disk drive requires a low level formatting and a high level
formatting to make it useful for data storage
• Low level formatting magnetically divides the disk into tracks
and sectors
• High level formatting is done on hard disk to make the disk
DOS compatible by writing DBR, FATs and empty root
directory information on the drive
 Low level formatting
• It is called physical formatting.
• Low-level formatting is the process of outlining the positions
of the tracks and sectors on the hard disk, and writing the
control structures that define where the tracks and sectors are.
• It really creates the physical format that defines where the
data is stored on the disk.
• Low level formatting is done in the factory itself.
 Functions of low level formatting
• Dividing the disk surface into tracks and sectors.
• Establishing interleave factor.
• Marking identification information on each track and sector.
• Marking defective sectors.

4M

Low
level
formatti
ng 2M
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 High level formatting
• High-level formatting is the process of setting up an empty file
system on a disk partition or logical volume and, for PCs,
installing a boot sector.
• After low level formatting and partitioning, final step for
preparing the hard disk drive for use is high level format the
drive
• High level format program need to only create File Allocation
Table, directory system etc. so that the operating system can use
the HDD for storage purpose.
• It creates the file system format within a disk partition or a
logical volume.
• It can be done during OS installation or new partition creation.
Explain LCD matrix types.
1) Active matrix:
 A transistor and a storage capacitor are integrated at each
cross point of electrodes.
 To address a particular pixel, proper row is switched on and
the change is sent down the correct column.
 Only the capacitor at the designated pixel receives the charge.
 Capacitor holds the charge until the next refresh cycle.

2) Passive Matrix:
 Consists of a grid of vertical and horizontal wires to display
an image on the screen.
 Each pixel is controlled by an intersection of two wires in the

High
level
formatti
ng 2M

4M

Active
matrix
2M

Passive
matrix
2M
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grid.
 By alluring the e-cal charge at a given intersection, the colour
and brightness of the corresponding pixel can be charged.

d)
Ans.

Describe different stages of the process of printing a document on
laser printer.
Laser Printer Printing Process:
Image Formation system
Image formation process revolves around a photo sensitive drum,
called organic Photo conductive (OPC) drum. This drum is located
inside the Electro photographic cartridge inside the laser printer.
Image formation process consists of following six steps
1. Cleaning of the OPC drum.
2. Conditioning of the OPC drum.
3. Electrostatically writing the image onto the OPC drum
4. Developing the image on the OPC drum.
5. Transferring of the image from OPC drum to the paper.
6. Fusing the image on the paper.

4M

Process
list 1M

1. Cleaning of the OPC drum
Before transferring any image to the OPC drums surface, the surface
needs to be cleaned and prepared to hold the image being transferred.
The drums surface is cleaned physically to remove any trace of the Correct
old toner particles from the previous printing operation and is cleaned Process
electro statically to remove any charge present on the drums surface explanat
from the last printing.
ion 3M
2. Conditioning of the OPC drum
In this process, a uniform charge of -600V is applied to the complete
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surface of the OPC drum.
3. Writing the image on the OPC drum
After the conditioning process its surface has a uniform -600V
potential.
To write any information on this drum laser beam is focused on the
selected areas of the drum. The area where laser strikes discharges to
ground and the area where laser does not strike remains at -600V.
Later this beam is focused and sent to the scanning mirror, the
scanning mirror sweeps the beam across the entire width of the OPC
drum.
Once one dot line of image is drawn on the OPC drum, the drum is
rotated by 1/300th of an inch, so that the beam can write the next line.
4. Developing the image on the OPC drum
When the image is completely written onto the drum, the latent image
is ready.
To transfer the latent image into a visible image the toner is
transferred to the discharged areas of the drum
The toner is a black plastic resin, powdery substance bound to iron
particles. It is also available in colors other than black.
The developer section consists of a rotating metallic cylinder, a
permanent magnet inside the cylinder, a toner cavity and a toner
height control blade.
The iron in the toner causes it to be attracted to the magnet inside the
developing cylinder. As the cylinder rotates, the height control blade
limits the amount of toner on the cylinder to a uniform thickness
The developing cylinder is connected to a negative power supply.
Hence the toner particles receive a negative charge from the cylinder.
This negative electrostatic charge causes the toner to be attracted to
the areas of the OPC drum which has been exposed to the laser beam
or those areas that contain the image to be printed.
5. Transfer of the image to paper
Once the image is developed on the OPC drum, using the corona wire
positive charge is given to the paper. The positive charge applied to
the paper is stronger than the charge on the OPC drum. This pulls the
negatively charged toner particles away from the drum to the paper.
As the paper and the drum move, the stiffness and the small radius of
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the drum makes the paper move away from the OPC drum.
This process of paper separation is assisted by a static charge
eliminator which weakens the attractive force between the drum and
the paper.

e)

Ans.

6. Fusing the image to the paper
It consists of a non stick roller, covered with Teflon type coating. The
roller is heated from inside using very high intensity quartz lamp.
The heated roller melts the toner and fuses it on the printing media.
Draw and explain block diagram of general UPS.
(Note: Diagram and explanation of On Line or Offline UPS shall
be considered)
Uninterrupted Power Supply Total loss of power can be avoided
with battery based power system. The UPS delivers uninterrupted
power to the ac load and it consists of following functional blocks
AC mains section contains filter, transformer and rectifier.
Battery charger with circuit and battery.
Static switch / contactor.
AC mains section
It receives ac supply, filters it with the help of line filters and rectifies
it to the desired level of the load.
This section can withstand ac input fluctuations from 170V to 250V.
Thus despite of ac fluctuations UPS can deliver 230V 50Hz output to
the load.
When ac supply is available it charges the battery through the battery
charger circuit.
Battery charger with circuit and battery
It converts the ac supply to the desired dc levels and charges
battery.
It has special protection to prevent overcharging of batteries.
The battery charger is SCR controlled converter that charges
battery
with constant current supply. The Battery specifications decide
time and amount of power delivered to the load. The batteries
usually specified using AH (Ampere Hour) as the unit.

4M

Explana
tion 2M

the

the
the
are
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Static Switch / contactor
In the event of power failure the inverter is connected to the load with
the help of switch. The inverter changes from the battery to ac of
constant frequency and amplitude.
It also has synchronization circuits for smooth change-over from
mains to inverter ac avoid waveform distortion.

Diagra
m 2M

f)
Ans.

What is POST? Enlist different error codes and respective
meaning provided by POST.
POST (Power On Self Test ):
The PC has built – in test programs which do their jobs as soon as the
PC is powered on. This Power OnSelf Test (POST) firmware is
stored in ROM on the motherboard. This ROM occupies the place
(address) from where the microprocessor starts instruction
processing, after a power on reset or hardware manual reset.
The POST is a series of simple programs designed to test and catch
faults in different hardware components and circuits.
If any hardware error is noticed, the POST indicates the fault to the
user through the following error codes:
Sr. No. Error Code
1
1XX
2
2XX
3
3XX
4
5XX

Meaning
System Board Error
Memory (RAM errors)
Keyboard Errors
Color Graphics Adapter Errors

4M

Definiti
on 1M

Any 3
error
codes
with
meanin
g 3M
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5
29XX
Color Printer Errors
6
48XX
Internal Modem Errors
7
104XX
IDE fixed disk or adapter errors
8
215XX
SCSI CD ROM drive errors
Attempt any TWO of the following:
16
Explain AGP with it’s types. Write advantages of AGP over PCI.
8M
It is a high speed bus for graphics and video support.
Features of AGP:
 It allows the video board to use system memory (RAM), as
3M
video memory.
Explana
 It is 4 to 8 times faster than PCI bus.
tion
AGP is a high speed connection and runs at a base frequency of
66.66MHz, which is double the standard PCI. In the basic AGP mode
called 1x, single transfer is in every cycle. As AGP bus is 32 bits (4
bytes) wide.
66 x 4 = 266MBps
In AGP 2x, two transfers are performed per cycle, giving 533MBps.
Because AGP is independent of PCI, using an AGP video card frees
up the PCI bus for I/O communications. AGP allows the video card to
a high speed connection to the system RAM.
Types of AGP:
In power, AGP video cards come in three flavors:
0.8v (newer) - 8X
1.5v (older) - 4X
3.3v (oldest) - 2X

1M
Type

2X and 4X AGP
Older 2X AGP cards do not use the right voltage to function properly
in the newer 1.5V AGP slots. If forced into a 1.5V AGP slot, a non1.5V compliant video card will damage the motherboard. On the
other hand a 1.5V AGP card is usually backwards compatible with
older 2X AGP slots.
8X AGP
Motherboards supporting 8x AGP support both 1.5V AGP 2.0
compliant cards (AGP 4x) and newer .8V AGP 3.0 compliant cards
(AGP 8x). The keying for AGP 3.0 cards is identical to that of AGP
2.0 cards to retain backward compatibility.
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Advantages over PCI:
 It provides a dedicated pathway between the slot and the
4M For
processor rather than sharing the PCI bus.
Advanta
 The direct connection allows for higher clock speeds.
ge of
 Pipelining – Multiple packets of data can be received or sent in a
AGP
single request.
 Sideband addressing - AGP issues eight additional lines on the
data packet just for addressing.
Describe FAT and explain FAT types compare FAT and NTFS.
8M
The file system in storage devices starts with FAT (File allocation
Table). 1. FAT refers to a data table that holds information about how
2M
and where files are stored in any partition 2. It is a kind of index used
for
by operating system to keep track of information stored on the hard
FAT
disk
FAT 16 - Hard drives use a 16-bit number termed as FAT16 to each
cluster. Here the configuration files of every sector are expressed by
16 bytes.
FAT 32 – It uses 32-bit values for the FAT entries. By assigning each
cluster its own number, it is possible to store files in any available
clusters throughout the drive without having to think about the actual
file’s size. As files are erased, these clusters become available for reuse.
Criteria

NTFS

2M for
type

FAT 32

OS

Windows 2000, XP,
2003 server

DOS V7, Win
2000,98,XP

Maximum
Volume Size

2TB

32GB

Max. Files on
Volume

Unlimited

4194304

Max file size

Limited by volume size

4GB

Max Cluster
Number

Unlimited

4177918

4M for
any 4
points
for
compari
son
between
FAT
and
NTFS
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location

1 and last

Compression

Yes

First sector and
copy in sector No
6
NO

Built in
security

Yes

NO

Recoverability Yes

NO

performance

c)
Ans.

st

High on large volume
Low on small volume

17428

Good on small
volume, Low on
large
Very little

Security

Folder and fie access
can be controlled
individually

Compatibility

Not compatible with
window 95/98/Me

Compatible with
all OS (32 bit)

Space
efficiency

Supports disk quotas to
control amount of disk
space per user

Does not support
disk quota

Explain working of Inkjet printer with neat block diagram.

8M

4M for
diagram

Functional Block Diagram
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Working of Inkjet Printer:
• In Inkjet Printer, we use an ink cartridge with nozzles.
• These printers eject ink drops on to the papers through nozzles to
form the characters. The ink cartridge has an ink reservoir and a set
of nozzles.
4M for
• It also has a firing chamber.
explanat
• To start the ink is drawn into the firing chamber.
ion
• The thin film resister at the bottom of the ink drop heats the ink up
to 900 degree Fahrenheit for a millionth of a second.
• This produces an ink bubble and it rejects the ink out of the firing
chamber through nozzle.
• The ejected ink drop is deposited on the paper to form a dot.
Attempt any FOUR of the following:
16
Explain PCI-X bus of Pentium IV mother board.
4M
PCI-X bus of Pentium IV mother board:
1. PCI –Express bus operates on hub architecture.
2. Each one of the PCI-Express device connects to the hub over
Any 4
dedicated link
features
3. The data communication in serial l is X1to X16 full duplex links
1M each
4. Data transfer rates from 500 Mbytes/s to 8 Gbytes/s
5. PCI express uses switching network star topology and doesn’t
require bus arbitration.
6. It transfers 64 bits at a speed of 133MHz.
7. It uses high speed serial signaling.
8. It works as a switched design for point to point communication
between the devices. Each device gets the full band width of the
system during transfers.
9. It does not use any control signals such as interrupts instead it
uses packet based system to exchange both data and command. In
the initial implementation PCI –X uses 4 wire interconnection
systems, 2 for sending and 2 for receiving.
OR
PCI-X







Peripheral Component Interconnect Extended
Supersede of PCI
Faster version of PCI with twice speed
Similar in physical implementation & basic design like PCI
Developed jointly by IBM, HP & Compaq.
Clock speed 66MHz to 133MHz
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 Data exchange between the processor & peripherals is of 1.06
GB/s
 Supports backward compatibility with previous versions.
Improves the fault tolerance
State meaning of cluster? How it is rectified.
(Note: Any one method how it can be rectified)
Cluster:
Whenever any information is stored on floppy or hard disk, it doesn’t
allocate the space sector-wise, instead it uses unit of storage termed
as “Clusters”
Clusters are minimum space allocated by OS when saving any
information on disk. A cluster can be made of 1 or more than 1
sectors. If OS specifies that, 1 cluster can store only 512 bytes of
information, then to store 513 bytes, 2 clusters shall be used.
Using clusters as allocation units reduces the size of FAT that OS
uses to keep track of used and empty disk space. Clusters are used to
allocate the storage area for data area only. FAT and directory area
are not allocated according to cluster size.
The cylinder or track number always starts from 0. The 1 sector
number is always -1 and 1st cluster number begins with 2.

b)
Ans.

4M

Meanin
g of
cluster
2M

(Note: Any one of the following shall be considered)













For Windows 10/8 users:
Open This PC > Right-click on System drive and choose Properties.
Go to Tools > Click Check.
Under Error-checking, click on Check.
Review the scan result > Click Scan and repair drive.
Choose when to repair the file system.
Wait for Windows 10/8 scan and repair the hard drive bad sectors.

2M for
explanat
ion of
rectified

Fix bad sector in Windows 7:
Open Computer > Right-click the hard drive you want to check for
bad sectors and select Properties.
In Properties window, click Tools > Check now in the Error-checking
section.
Click Scan for and attempt recovery of bad sectors > Click Start.
Review the check disk report.
How to Repair a Bad Sector in Windows XP?
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Close all programs and files > Open My Computer;
Choose a hard drive and right-click on it > Select Properties;
Click Tools under Properties > Click Check Now in Error-checking
section;
Choose Check Disk options to check and repair bad sectors:
Automatically fix file system errors and click Start;
If an error message pops up, asking you if you'd like to schedule the
disk check when you restart the computer, click Yes to restart the
computer and repair bad sectors;
Review the check disk report: 0 means no errors were found, 1 means
that errors were found and fixed.



OR
(Note: Any one of the following shall be considered)
1 Change cluster size in Windows File Explorer
Format Partition to Change Cluster Size: There are two ways to
format
partition
and
change
cluster
size: Windows
Explorer and command prompt diskpart


1. press Win+E to run Windows Explorer, right click on the partition
you want to format, take partition G: for example
NOTE: You can copy volume to backup data if you want to change
cluster size without data loss.



2. click Allocation Unit Size (Cluster Size), select 64 kilobytes,
select Quick Format > Start
3. Format warning message shows up, click YES to continue.
4. After a while, format complete.












2. Change cluster size in command prompt diskpart
1. Type cmd in Start menu, run command prompt as administrator
and type the following command in order
2. diskpart
3. list disk
4. select disk 2
5. list partition
6. select partition 2
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7. format fs=ntfs quick unit=64k
8. exit



3. Format Partition to change cluster size in Partition Expert
In Partition Expert, there are two ways to change cluster size:
format partition and create new partition to change cluster size




1. Run Partition Expert, click on the Partition you want to change
cluster size and Choose Format Volume ;
2. Select 64k in Cluster size column
> select Quick Format, (or just leave it as default setting)
3. Click OK to close this format window, and in the main interface,
we click Commit
so that we can have a 64K cluster sized partition.



4. Create Partition to define cluster size in Partition Expert
Create Partition in Partition Expert is another way of making 64k
cluster size, when you have a new disk installed, disk space is
unallocated, you can create partition and define cluster size as 64k at
the same time.




c)
Ans.

1. Run Partition Expert, click on unallocated space and click Create
Volume
2. In the popup window, define Volume Label, assign drive letter;
define file system; choose cluster size; define volume type
3. Click OK, > Commit.
Explain block diagram of video accelerator card.
4M
Need:
1. For higher resolutions, the data needed to form a single screen
image can be large.
2. System also needs data for operations such as memory refresh,
2M for
keyboard, mouse handling, drive access etc.
explanat
3. This results in video data bottlenecks.
ion
Solution:
1. Incorporate processing power onto video board (rather than CPU)
for graphics data processing.
2. A graphics accelerator application specific chip (ASIC) that
intercepts graphics tasks and processes them without the
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5.

6.
7.
8.

17428

intervention of system CPU.
Core of the accelerator is the graphics chip which connects
directly to PC expansion bus.
Graphics instructions and data are translated into pixel data and
stored in video RAM.
VRAM offers second data bus that is routed directly to
RAMDAC (Random Access Memory Video to Analog
Converter).
Graphics chip directs RAMDAC operation and ensures that
VRAM data is available.
RAMDAC translates video data into R, G, and B video signals
along with vertical and horizontal signals.
Output signals generated by the RAMDAC drive the monitor.

2M for
block
diagram

d)
Ans.

Explain use of output voltage of SMPS.
Voltage sense section It generates Power Good Signal (PGS).
When all four voltage outputs (+5V, -5V, +12V, - 12V) are steady
above minimum sense levels for more than 100ms, PGS is generated
by this section. It checks the maximum load current and compares it
with specified current.

4M

If the connected load exceeds the specified load, current limit circuits
shut off the output section of the SMPS, thereby avoiding damage
due to over current flow.
For ATX

Page 36 / 38

MAHARASHTRA STATE BOARD OF TECHNICAL EDUCATION
(Autonomous)
(ISO/IEC - 27001 - 2005 Certified)
MODEL ANSWER
SUMMER – 2018 EXAMINATION
Subject: Computer Hardware & Maintenance
Subject Code:

e)
Ans.

Wire colour

DC Voltage

DC Voltage

Red
Yellow
Black
Blue
Grey
Green
Purple
Orange
Brown/Orange

+5 V
+12V
Ground
-12V
Power Good
Power On
+5V StandBy
+3.3V
+3.3V Sense

All logic families
Drive Motors

White

-5V (optional)

For serial port

17428

Any 4
voltage
4M

Latest Processor

Vcc for DRAM
refreshing
What is centronics? Explain modes of operations of centronics
4M
interface.
The Centronics interface is a standard input/output (I/O) interface
designed in the 1970s for connecting printers and other devices.
2M for
This standard specifies five modes of operation, each mode providing explaini
data transfer in either the forward direction (computer to peripheral),
ng
backward direction (peripheral to computer), or bi-directional (one centroni
direction at a time).
cs
 Compatibility mode is the original Centronics parallel interface interfac
and intended for use with dot matrix printers and older laser
e
printers.
 Nibble mode allows data transfer back to the computer. The
nibble mode uses the status lines to send 2 nibbles (4-bit units) of
data to the computer in two data transfer cycles. This mode is best
used with printers.
 Byte mode: One byte of data is transferred instead of the two data
cycles required by the nibble mode.
 ECP mode (Enhanced Capability Port mode) is an advanced bidirectional mode for use with printers and scanners. It allows data
compression for images, FIFO (first in, first out) for items in
queues, and high-speed, bi-directional communication. Data
transfer occurs at two to four megabytes per second. An advanced
feature of ECP is channel addressing. This is used for
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multifunction devices such as printer/fax/modem devices. For
example, if a printer/fax/modem device needs to print and send
data over the modem at the same time, the channel address
software driver of the ECP mode assigns a new channel to the
modem so that both devices can work simultaneously.
 EPP mode (Enhanced Parallel Port mode) was designed by Intel,
Xircom, and Zenith Data Systems to provide a high-performance
parallel interface that could also be used with the standard
interface. The EPP mode uses data cycles that transfer data
between the computer and the peripheral and address cycles that
assign address, channel, or command information.
Explain any one software tool for debugging PC.
Software tools Microsoft diagnostics DOS MSD command:
. Norton utilities.
 CHECKIT.
 Quick analysis (QA+).
 ATDIAGS POST
 Power on Self Test
(POST) Give the test sequence of post:
1. CPU test
2. BIOS ROM Checksum test
3. Timer 1 test
4. DMA controller test
5. 16 KB DRAM test
6. Interrupt controller initialization
7. Interrupt controller test
8. Timer 0 initialization
9. CRT controller test
10. DRAM after 16 KB test
11. Keyboard test
12. Disk drive test

2M for
explaini
ng the
mode of
operatio
n

4M
1M for
listing
all the
tool

3M for
explaini
ng any
one tool
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